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appendix 
C

The Editor, Menu by Menu

The Editor’s menus are far more complex than the Organizer’s menus. All three 
of the Editor’s modes—Full Edit, Quick Fix, and Guided Edit—have the same 
menus, although some choices are grayed out when you’re in Quick Fix or 

Guided Edit mode. When you need a menu item that’s not available in Quick Fix or 
Guided Edit, just switch back to Full Edit to use it.

Several of the menus in Elements are dynamic, meaning they change quite a bit to 
reflect the choices currently applicable to your image. That means the choices you 
see in this appendix represent only what you may see depending on the situation. 
The Layer menu, for instance, offers you very different options depending on the 
current state of your image and which layer is active.

Note: If you have Adobe Premiere Elements installed, then you’ll see some extra menu options not 
included in this basic list. Also, in Windows, you may see all these choices in one menu row (in the order 
listed here), or you may have two rows of menu items, depending on the size of your Elements window. 
Whether you have a Mac or a PC, your menu choices are nearly identical, except for the leftmost menu, as 
explained below.

System Menu (Windows only)
The dark blue square with lighter blue squares on it, at the upper-left corner of the 
Elements window, is actually a button. Click it to get a pop-out menu for closing, 
moving, maximizing, and minimizing the Editor, as well as for restoring it to its 
original size.
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Menu (Mac only)

Photoshop Elements Menu (Mac only)
These menu choices provide info about Elements, let you adjust some of its settings, 
and control the program’s visibility.

Note: The leftmost item in your menu bar, the Apple menu, is system-wide and not part of Elements.

About Photoshop Elements
Choose this to see a window about the version of Elements you have. It includes a 
long list of patents and credits—a testimony to the complexity of the engineering 
that went into Elements.

About Plug-in
Select this option for a long pop-out menu displaying all the plug-ins in your copy of 
Elements. Choose a plug-in from the list to see its version and date info.

Legal Notices
This item displays a list of the various patents for Elements, as well as trademark 
information for some of the components used in the program.

Preferences
This menu item gives you access to the many Elements settings you can customize. 
You’ll find the following preference windows available from this menu:

• General (or press �-K)

• Saving Files

• Performance (where you set the number of history states and assign scratch 
disks—see page 615)

• Display & Cursors

• Transparency

• Units & Rulers

• Guides & Grid

• Plug-Ins

• Type

• Organize and Share (this is a link to the Organizer’s preferences)
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Services
In OS X Leopard (10.5), this is where you can access the OS X utility programs 
like Grab (for taking screenshots) or TextEdit (for copying text). Your exact choic-
es here depend on what programs you have installed on your Mac. It’s normal for 
some to be grayed out. Dictionary, for instance, isn’t available unless some text is 
highlighted. In OS X Snow Leopard (10.6) or Lion (10.7), you can control what ap-
pears in this menu (it’s empty when you first install Elements) by going to System 
Preferences➝Keyboard➝Keyboard Shortcuts➝Services.

Hide Photoshop Elements
If you don’t want Elements to be visible, choose this item or press Control-�-H.

Hide Others
If you want Elements to be your only visible program, choose this option or press 
Option-�-H.

Show All
Use this to bring all your hidden programs back into view.

Quit Photoshop Elements
You can shut Elements down by choosing this menu item, or by pressing �-Q.

File Menu
The commands listed here let you create, import, open, save, and print files.

New
Choose this menu item if you want to start a new file in Elements. Your options are:

• Blank File (or press Ctrl+N/�-N).

• Image from Clipboard. This automatically pastes into a new file anything 
you’ve copied.

• Photomerge Group Shot. This lets you move a person from one photo of a 
group into another photo of the same group (page 376).

• Photomerge Faces. Use this one to combine parts of different faces for carica-
tures and other fun effects (page 373).

• Photomerge Scene Cleaner. This feature lets you remove unwanted people or 
details from a photo by copying over bits of other photos (page 377).
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• Photomerge Panorama. Use this option to combine your photos into panora-
mas (page 366).

• Photomerge Exposure. Choose this item to combine bracketed shots into one 
properly exposed photo (page 366).

• Photomerge Style Match. This new feature lets you copy the retouching style 
from one image to another (page 379).

Open
Choose this menu item or press Ctrl+O/�-O to open an existing file.

Open As (Windows only)
This menu option (or Alt+Ctrl+O) lets you choose the format for a file as you open 
it. Select it when you want to use the Raw Converter with non-Raw formats like 
JPEG or TIFF (page 286).

Open Recently Edited File
Here’s where you’ll find a pop-out list of the most recent files you’ve had open in Elements.

Duplicate
When you need to make a copy of your photo, choose this option. Elements names 
the copy the same thing as the original with “copy” tacked onto the end, though you 
can change the copy’s name in the dialog box that appears.

Close
To close the active image window, choose this menu item or press Ctrl+W/�-W.

Close All
To close all your open image windows, choose this option or press Alt+Ctrl+W/
Option-�-W.

Save
To save your work, select this option or press Ctrl+S/�-S.

Save As
To save your image under another name or in a different format, choose this com-
mand or press Shift+Ctrl+S/Shift-�-S.
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Save For Web
To save an image so that it’s optimized for posting on a web page or sending by email, 
choose this menu item or press Alt+Shift+Ctrl+S/Option-Shift-�-S. For more on 
the Save For Web window, see page 554.

File Info
Choose this menu item to bring up the File Info window, which includes all sorts of 
information about your image, like file creation date, file format, and so on.

Place
Use this command to place a PDF, Adobe Illustrator, or EPS file into an image as 
a new layer. If the artwork is larger than the image you place it in, Elements auto-
matically makes it small enough to fit. Anything that you put into a file with this 
command (including objects from images in regular formats like TIFF or JPEG) 
becomes a Smart Object (page 514).

Organize Open Files
Choose this menu option to add the files you have open in the Editor to the Orga-
nizer.

Process Multiple Files
This is where you batch-process files to rename them, change their format, add 
copyright info, and so on (see page 298 to learn everything that Elements lets you 
do to groups of files).

Import
This is where you bring certain file formats into Elements. It’s also where you can 
connect to external devices like scanners. (They’ll show up in this menu if you install 
their drivers, and if those drivers include a compatible plug-in. If you have a Mac, be 
sure to read page 50.) Your basic choices before you connect or install anything are:

• Anti-aliased PICT (Mac only). This is for importing PICT objects created in 
programs like MacDraw or Canvas. Anti-aliasing makes them appear smooth.

• PICT Resource (Mac only). A type of PICT file used in the resource fork of a 
Mac file, for things like an application’s opening screen. (All Mac files have two 
parts, a data fork and a resource fork.)

• Frame from Video (page 51)

• WIA Support (Windows only). The built-in support for scanners that’s part of 
the Windows operating system.
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Export
This command is always grayed out. That’s normal. Adobe left it in for the benefit of 
any third-party plug-ins that may need it—but you don’t need it in Elements to use 
the program’s standard tools and commands. (In Windows, if you need to export 
files, you can do that from the Organizer—see page 527. On a Mac, use the Orga-
nizer’s Copy/Move command, or just do a Save As.)

Automation Tools
Like Export, this command is only here for a few third-party plug-ins that may need 
it. Normally, it’s grayed out.

Print
Choose this command and you get the Print window, which is discussed in detail in 
Chapter 16. Keyboard shortcut: Ctrl+P/�-P.

Order Prints
This is your portal to connecting to Kodak Gallery or Shutterfly to order prints, cal-
endars, or photo books. (See page 526 to learn how to order prints online.) Choose 
this item, and Elements switches you over to the Organizer, and then connects you 
from there.

Export Creations
When you’ve made a Create project (see Chapter 15), you can use this menu item to 
save your creation to the location of your choice as separate JPEG, TIFF, or PDF files 
for each page. This is especially handy if you don’t use the Organizer, or if you want 
to use one of the templates meant for the online services (a Kodak photo book, for 
instance) without actually ordering your project there.

Contact Sheet II (Mac only)
To make a contact sheet showing thumbnails of many photos (see page 547), choose 
this menu item or press Option-�-P.

Picture Package (Mac only)
To print several photos—or multiple copies of one photo—in different sizes on one 
page (see page 549), choose this command.
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Exit (Windows only)
You can close the Editor by selecting this item or by pressing Ctrl+Q. The Organizer 
doesn’t quit along with the Editor, though, so if the Organizer is also running, you 
have to exit it separately.

Edit Menu
The choices listed here let you make changes to your files. In Windows, this is also 
where you access your Elements preferences to change their settings.

Undo
To back out of your last action, select this item or press Ctrl+Z/�-Z. You can keep 
applying this command to undo as many steps as you’ve set in the Undo History 
panel’s preferences (Edit➝Preferences➝Performance➝History States/Photoshop 
Elements➝Preferences➝Performance➝History States).

Redo
If you undo something and then change your mind, redo it here or press Ctrl+Y/�-Y.

Revert
Choose this command to return your image to the state it was in the last time you 
saved it.

Cut
To remove something from your image and store it on the Clipboard (so you can 
paste it into another file), choose this menu item or press Ctrl+X/�-X.

Copy
To copy something to the Clipboard, highlight it and select this menu item or press 
Ctrl+C/�-C. This command copies only the top layer in a layered file, however. To 
copy all the layers in your selected area, use Copy Merged instead.

Copy Merged
To make a single, combined copy of all the layers in the selected area to the Clip-
board, choose this menu option or press Shift+Ctrl+C/Shift-�-C. To copy just the 
active layer to the Clipboard, use Copy instead.
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Paste
Use this command or press Ctrl+V/�-C to add whatever you’ve cut or copied to an 
image.

Paste Into Selection
Use this special command to paste something within the confines of an existing 
selection. See page 155 for more on how this command works. Keyboard shortcut: 
Shift+Ctrl+V/Shift-�-V.

Delete
This command removes what you’ve selected without copying it to the Clipboard—
it’s just gone. You can press Backspace to do the same thing.

Fill Layer, Fill Selection
Choose this menu item to fill your active layer with a color or pattern (page 320). 
When you make a selection in your image, this menu item changes to read “Fill Se-
lection”. You can also choose a blend mode and opacity for your fill.

Stroke (Outline) Selection
This command puts a colored border around the edges of a selection.

Define Brush, Define Brush from Selection
If you want to create a custom brush from your photo or from an area of your photo, 
choose this command. The process is explained in detail on page 407.

Define Pattern, Define Pattern from Selection
This command creates a pattern from your image or selection. See page 320 for more 
about applying patterns.

Clear
Use this command to permanently remove information from the Undo History pan-
el, the Clipboard, or both (choose All). If you have a corrupt image in the Clipboard 
(or one that’s too large), it may cause Elements to slow way down or quit on you. 
Once in a while, the Clipboard may get stuck, too—meaning that when you try to 
copy and paste an item, you just get whatever you copied previously. This command 
fixes such problems.
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Add Blank Page
This command lets you add a new, blank page to your current project. (Page 515 has 
more about working with multipage files.) Keyboard shortcut: Alt+Ctrl+G/Option-�-G.

Add Page Using Current Layout
If you create a photo collage (page 505) or other elaborate layout and you want to use 
that page as a template for new pages, choose this command instead of Add Blank 
Page. Keyboard shortcut: Alt+Shift+Ctrl+G/Option-Shift-�-G.

Delete Current Page
If you’re working with a multipage document and want to get rid of your current 
page, choose this command.

Remote Connections
If you’re using one of Adobe’s new mobile apps (see page 4), this is where you set 
things up to allow your iPad or other device to connect to Elements.

Color Settings
Here’s where you choose a color space for Elements (page 241). Keyboard shortcut: 
Shift+Ctrl+K/Shift-�-K.

Preset Manager
This is where you access the window that helps you manage your brushes, swatches, 
gradients, and patterns. See page 604 for more on how the Preset Manager works.

Preferences (Windows only)
This menu item gives you access to the many Elements settings you can customize. 
(In OS X, you get to Elements’ preferences through the Photoshop Elements menu.) 
You’ll find the following preference windows available here (they’re discussed in de-
tail in the appropriate parts of this book):

• General (or press Ctrl+K)

• Saving Files 

• Performance (where you set the number of history states and assign scratch 
disks—see page 615)
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• Display & Cursors 

• Transparency 

• Units & Rulers 

• Guides & Grid 

• Plug-Ins 

• Type 

• Organize & Share (brings up the Organizer’s preferences)

Image Menu
This menu lets you make changes to your image by doing things like rotating it, 
changing its shape, cropping or resizing it, or changing its color mode.

Rotate
Use these commands to change the orientation of your image (page 91). The first 
group of options applies to your whole image:

• 90° Left 

• 90° Right 

• 180° 

• Custom 

• Flip Horizontal 

• Flip Vertical 

The next group does the same thing but to a layer or selection. The menu choices 
change depending on whether you have an active selection in your image; if you 
have a selection, you’ll see the word “Selection” instead of “Layer.”

• Free Rotate Layer 

• Layer 90° Left 

• Layer 90° Right 

• Layer 180° 

• Flip Layer Horizontal 

• Flip Layer Vertical 
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Finally you can choose to:

• Straighten and Crop Image 

• Straighten Image 

These last two commands are mostly for when you need to straighten whole scanned 
images. To straighten the contents of an image, use the Straighten tool instead (page 
94).

Transform
These commands let you change the shape of your image by pulling it in different 
directions (they’re explained in detail on page 391). Your choices are:

• Free Transform (Ctrl+T/�-T) incorporates the other three commands.

• Skew slants an image.

• Distort stretches your photo in the direction you pull it.

• Perspective stretches your photo to make it look like parts are nearer or farther 
away.

Tip: You might prefer to start with the Correct Camera Distortion filter for transforming your images to 
correct perspective; see page 383.

Crop
Choose this menu item to crop your image to the area you’ve selected (page 99).

Recompose
Use this to bring up the handy Recompose tool (page 323), which lets you reshape 
photos without distorting them and eliminate unwanted objects in them at the same 
time. You can also press Alt+Ctrl+R/Option-�-R or click its icon in the Tools panel.

Divide Scanned Photos
If you place several photos on your scanner glass at once and then choose this com-
mand, Elements cuts your photos apart and straightens and crops each one. See page 
89 for more about how this works.
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Resize
Here’s where you change the actual size of your image (as opposed to changing the 
size of the view on your screen). Your choices are:

• Image Size (page 114). Keyboard shortcut: Alt+Ctrl+I/Option-�-I.

• Canvas Size (page 122). Keyboard shortcut: Alt+Ctrl+C/Option-�-C.

• Reveal All. If you drag a layer from another image into your photo and part of 
the layer falls outside the perimeter of the target image, use this command to 
see the entire dragged layer. It basically resizes the canvas to fit all of the images. 
Also, some versions of Photoshop hide the area outside a selection when you 
use the Crop tool. When someone sends you one of these images, use this com-
mand to see the area that was hidden by the crop.

• Scale (page 398).

Resizing is explained in detail in Chapter 3.

Mode
This is where you can change the color mode for your image (page 54). Your choices 
are:

• Bitmap 

• Grayscale 

• Indexed Color 

• RGB Color 

You’ll also find two commands in this menu:

• 8-bits/Channel reduces images from 16-bit color to 8-bit (see page 285).

• Color Table shows you the color table (the colors of your image as swatches) for 
an Indexed Color image.

Convert Color Profile
If you need to change the ICC (International Color Consortium) profile of an image, 
you can do it from this menu item, which lets you apply an sRGB or Adobe RGB pro-
file, or remove the profile from an image. For more on color profiles, go to page 244.

Magic Extractor
Use this command or press Alt+Shift+Ctrl+V/Option-Shift-�-V to call up the Mag-
ic Extractor window, which automates the process of selecting an object in your 
photo and removing it from the background. See page 169 for details.
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Enhance Menu
This menu contains the commands you use to adjust the color and lighting of your 
images. The first six options apply changes automatically, and the remainder let you 
adjust your changes.

Auto Smart Fix
Choose this option or press Alt+Ctrl+M/Option-�-M to have Elements adjust your 
image’s lighting, color, and contrast all at the same time (page 135).

Auto Levels
Use this command or press Shift+Ctrl+L/Shift-�-L to make Elements adjust your 
image’s individual color channels (page 138).

Auto Contrast
Choose this command or press Alt+Shift+Ctrl+L/Option-Shift-�-L, and Elements 
adjusts the brightness and darkness of your image without changing the colors (page 
138).

Auto Color Correction
Use this option or press Shift+Ctrl+B/Shift-�-B to have Elements adjust your im-
age’s color in much the same way that Levels does. Auto Color Correction looks at 
different information in your photo to make its decisions, though (page 140).

Auto Sharpen
This command applies the same one-click sharpening you get when you use the 
Auto Sharpen button in Quick Fix (page 142).

Auto Red Eye Fix
Use this command or press Ctrl+R/�-R to apply the same auto red-eye correction 
found in the Organizer (page 133).

Adjust Smart Fix
This command is the same as Auto Smart Fix, except you get a slider to adjust 
the degree of change that Elements makes to your photo. Keyboard shortcut: 
Ctrl+Shift+M/�-Shift-M.
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Adjust Lighting
Your choices for adjusting the light and dark values in your photos are:

• Shadows/Highlights (page 231).

• Brightness/Contrast (page 138).

• Levels. You can also press Ctrl+L/�-L to bring up the Levels dialog box (page 
244).

Adjust Color
With these settings, you can change a color, replace a color, remove a color cast, 
remove all the color from your image, or add color to a black-and-white photo. 
Choose from:

• Remove Color Cast (page 252).

• Adjust Hue/Saturation (page 331). Keyboard shortcut: Ctrl+U/�-U.

• Remove Color (page 349). Keyboard shortcut: Shift+Ctrl+U/Shift-�-U.

• Replace Color (page 337).

• Adjust Color Curves (page 327). The Color Curves tool lets you adjust the 
brightness and contrast of specific tonal ranges in your photo (like highlights 
or midtones).

• Adjust Color for Skin Tone (page 147). This setting adjusts the colors in your 
image based on the skin tones of someone you select in the photo.

• Defringe Layer (page 174). This setting gets rid of the rim of contrasting pixels 
you may get when you remove an object from its background.

• Color Variations (page 253).

Convert to Black and White
Use this menu item or press Atl+Ctrl+B/Option-�-B to convert a color photo to a 
black-and-white image (page 345).

Unsharp Mask
This is the most popular traditional method for sharpening your photos (page 261).

Adjust Sharpness
Choose this menu item to use Adobe’s newest sharpening tool (page 263).
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Layer Menu
Here’s where you’ll find the commands for creating and managing layers (Chapter 6 
is all about layers). This is the most dynamic menu in Elements—what you see at the 
bottom of the menu changes depending on the layers in the open image and on the 
characteristics of the active layer. This is a basic rundown of the main menu options 
you’ll usually see if your open image has only a Background layer. (Sometimes you’ll 
see choices that are visible but grayed out.) The choices for merging and combining 
layers change the most as your layers change.

New
This is where you create new, regular (as opposed to Adjustment) layers. Your options are:

• Layer or press Shift+Ctrl+N/Shift-�-N.

• Layer from Background. If your image doesn’t currently have a Background 
layer, you see “Background from Layer” instead of “Layer from Background”.

• Layer via Copy (page 194) or press Ctrl+J/�-J.

• Layer via Cut (page 194) or press Shift+Ctrl+J/Shift-�-J.

Duplicate Layer
Use this command to make a copy of the active layer. As long as you don’t have a 
selection, you can also use Ctrl+J/�-J to do the same thing.

Delete Layer
If you want to eliminate a layer, click it in the Layers panel to make it the active layer, 
and then choose this command.

Rename Layer
Choose this option to—you guessed it—change a layer’s name. You can also double-
click the layer’s name in the Layers panel to rename it.

Layer Style
If a layer has a Layer style applied to it (page 456), you can adjust it here:

• Style Settings brings up the dialog box where you can adjust some of the Layer 
style’s settings. (Double-clicking the Layer style icon in the Layers panel—the 
little “fx” to the right of the layer’s name—brings up the same dialog box.)

• Copy Layer Style lets you copy to the Clipboard any styles applied to a layer, so 
you can apply them to another image or layer.
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• Paste Layer Style applies your copied style to a new layer, even in a new image.

• Clear Layer Style removes all the styles applied to a layer.

• Hide All Effects hides all the styles applied to a layer so you can see what your 
image looks like without them. If you hide all the styles, this menu item reads 
“Show All Effects” instead.

• Scale Effects lets you adjust the size of certain aspects of Layer styles.

New Fill Layer
Choose this option to create a layer that’s filled with a color, gradient, or pattern. 
(You can also do this from the Layers panel by clicking the Create Adjustment Layer 
icon [the black-and-white circle]). They’re explained on page 218. Your options are:

• Solid Color

• Gradient)

• Pattern

New Adjustment Layer
This command, not surprisingly, creates a new Adjustment layer (page 218). The 
types of layers you can create here are:

• Levels (page 244)

• Brightness/Contrast (page 229)

• Hue/Saturation (page 331)

• Gradient Map (page 470)

• Photo Filter (page 297)

• Invert (page 341)

• Threshold (page 342)

• Posterize (page 342)

Layer Content Options
If you have a Fill layer selected, choosing this menu item brings up a dialog box 
where you can adjust the active layer’s settings. 



607appendix c: the editor, menu by menu

Layer Menu

Type
This command gives you ways to modify a Text layer, as long as you haven’t simpli-
fied it (page 426). You can choose:

• Horizontal. Change vertical text to horizontal text.

• Vertical. Change horizontal text to vertical text.

• Anti-Alias Off. Anti-aliasing is explained on page 481.

• Anti-Alias On.

• Warp Text. See page 482.

• Update All Text Layers.

• Replace All Missing Fonts. If your image is missing fonts, this command re-
places them, but you can’t choose which font Elements uses as the replacement. 
It’s usually just as easy to replace fonts by highlighting the text and selecting a 
new font in the Options bar.

Simplify Layer
This command rasterizes your layer, turning the layer’s contents from a vector or 
Smart Object to one that’s built pixel by pixel. See page 426 for more about the dif-
ference between vectors and pixels.

Layer Mask
Elements 9 lets you create layer masks, which you can use to hide part of the content 
of a layer (page 211). You can create a mask from the Layers panel, or you can create 
and manage masks from this menu item. Your choices here are:

• Reveal All. Creates a new layer mask that starts out empty (you can see the 
entire contents of the layer).

• Hide All. Creates a new mask that hides everything on the layer so that you can 
reveal just the parts you want to show.

• Reveal Selection. If you have an active selection (see Chapter 5), this command 
creates a new mask that hides everything except the selected area.

• Hide Selection. If you have an active selection, this creates a new mask that 
shows everything except the selected area.

• Delete. Gets rid of an existing layer mask.

• Apply. If you have a layer mask and you want to permanently reduce the layer to 
only the area that’s currently visible, this is how you do it. (It’s usually not a good 
idea, though, since once you do this and close the image, there’s no going back.)
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• Disable. If you want to see your image without the mask, this command turns it 
off. If you’ve disabled the mask, the menu item reads Enable instead.

• Unlink. If you want to be able to slide the mask around (for better framing of 
your subject, for instance), choose this item or click the little chain icon in the 
Layers panel.

Create Clipping Mask, Release Clipping Mask
This command links two layers together so the bottom layer determines the opac-
ity of the top layer (page 206). If you’ve used earlier versions of Elements, this is the 
same as the old “Group with Previous” command. When you have clipped layers, 
this item changes to read “Release Clipping Mask” instead. Keyboard shortcut for 
either: Ctrl+G/�-G.

Arrange
Use these commands to change the order of layers in the layers stack, or just drag 
them in the Layers panel. See page 200 for details on rearranging layers. (“Front” is 
the top of the stack, and “Back” is directly above the Background layer.) Your options 
are:

• Bring to Front (or press Shift+Ctrl+]/Shift-�-]).

• Bring Forward (or press Ctrl+]/�-]).

• Send Backward (or press Ctrl+[/�-[).

• Send to Back (or press Shift+Ctrl+[/Shift-�-[).

• Reverse. Select two or more layers, and then choose this command to reverse 
the order in which they appear in the layer stack.

Merge Layers
Choose this command or press Ctrl+E/�-E to combine multiple layers into one 
layer. You may also see Merge Down listed here, which merges a layer with the layer 
immediately beneath it, or Merge Clipping Mask, which merges grouped layers.

Merge Visible
Use this option or press Shift+Ctrl+E/Shift-�-E to merge all the visible layers into 
one layer.

Flatten Image
This command merges all the layers in your file into one Background layer.
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Select Menu
Here’s where you make, modify, and save selections. (See Chapter 5 for more about 
selections.)

All
Choose this command or press Ctrl+A/�-A to select your whole image.

Deselect
Use this command or press Ctrl+D/�-D to remove all selections from your image.

Reselect
If you use the Deselect command but then want your selection back again, choose 
this menu item or press Shift+Ctrl+D/Shift-�-D.

Inverse
This command switches the selected and unselected areas of your image so that the 
area that wasn’t previously selected is now selected, and the previously selected area 
is now unselected. Keyboard shortcut: Shift+Ctrl+I/Shift-�-I.

All Layers
Use this command to select all the layers in your image, including hidden layers.

Deselect Layers
Choose this option to unselect all the layers in your image.

Similar Layers
Use this command to select all the layers of your image that are the same type, such 
as all Adjustment layers or all Text layers.

Feather
Choose this option or press Alt+Ctrl+D/Option-�-F to feather (blur) the edges of a 
selection (page 165).
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Refine Edge
This command lets you groom the edges of a selection (page 159).

Modify
These commands let you change the size or edges of your selection (they’re all ex-
plained in Chapter 5):

• Border selects the edge of your selection (page 180).

• Smooth rounds the corners of selections (page 180).

• Expand moves the edge of your selection outward (page 178).

• Contract moves the edge of your selection inward (page 178).

Grow
This command expands your selection to include contiguous areas of similar color 
(page 178).

Similar
This option expands your selection to include more areas of similar color, but—un-
like the Grow command—it doesn’t restrict the growth to contiguous areas (page 
178).

Transform Selection
This command lets you adjust the size of a selection by dragging its edges (page 177). 
You can also reshape it with any of the Transform commands (page 389).

Load Selection
If you’ve saved a selection, choose this command to use it again.

Save Selection
If you want to save a selection so you can use it later without recreating it, select this 
command (page 182).

Delete Selection
Use this command to permanently remove a saved selection.
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Filter Menu
Filters let you change the appearance of your image in all sorts of ways, as Chapter 
13 explains in detail. Elements comes with some filters that are mostly for correct-
ing and improving your photos, and some that create artistic effects. You can apply 
filters from this menu or from the Effects panel. The filters are grouped into catego-
ries to make them easier to find. Every image responds to filters differently, so the 
descriptions here are only a very rough guide.

Last Filter
The top item in the Filter menu always features the last filter you applied. Choose it 
or press Ctrl+F/�-F to reapply that filter with the same settings you previously used. 

Filter Gallery
This option lets you try the effects of different filters, rearrange them, and preview 
what they’ll look like in your photo (page 437).

Correct Camera Distortion
Use this filter to correct various kinds of lens distortion problems (page 383).

Adjustments
This group of filters is primarily (but not exclusively) for correcting and enhancing 
photos. These filters are discussed on page 341 unless otherwise noted:

• Equalize 

• Gradient Map (page 470)

• Invert (or press Ctrl+I/�-I)

• Posterize 

• Threshold 

• Photo Filter (page 297)

Artistic
Use these filters to apply various artistic effects to your image, ranging from a pencil-
sketch look to a watercolor effect:

• Colored Pencil makes your photo look like it was sketched with a colored pen-
cil on a solid-colored background.

• Cutout makes your image look like it was cut from pieces of paper.
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• Dry Brush makes your photo look like it was painted using a dry brush.

• Film Grain adds grain to make your photo resemble old film.

• Fresco makes your photo look like it was painted quickly in a dabbing style.

• Neon Glow adds vivid color to your image while softening the details.

• Paint Daubs gives your photo a painted look.

• Palette Knife makes your photo look like you painted it with a palette knife. 
While you may think of a palette knife as a tool for blending heavy paint daubs, 
Adobe describes the effect of this filter as looking like a thin layer of paint that 
reveals the canvas beneath it.

• Plastic Wrap makes your image look like it’s covered in plastic.

• Poster Edges gives your image accented, dark edges while reducing the number 
of colors in the rest of the photo.

• Rough Pastels makes your image look like it was quickly sketched with pastels.

• Smudge Stick uses short, diagonal strokes that soften the image by smearing 
the detail.

• Sponge paints with highly textured areas of contrasting color like you’d get by 
sponging on color.

• Underpainting makes your image look like it’s painted on a textured back-
ground.

• Watercolor simplifies the details in your image the way they would be if you 
were creating a watercolor painting.

Blur
You can soften and blur your images with these filters:

• Average (page 448).

• Blur.

• Blur More.

• Gaussian Blur (page 445).

• Motion Blur. You apply this pretty much the same way as the Radial blur, de-
scribed on page 447, but it creates a one-way blur, like you’d see behind Road 
Runner when he’s scooting away from Wile E. Coyote.

• Radial Blur (page 447).

• Smart Blur. This filter reduces grain and noise without affecting the edge 
sharpness of your photo. It’s also used for special artistic effects.

• Surface Blur. This filter blurs without reducing edge contrast (page 449).
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Brush Strokes
These filters give your image a hand-painted look:

• Accented Edges emphasizes the edges of objects as though they were drawn in 
black ink or white chalk.

• Angled Strokes creates diagonal brushstrokes that all run in the same direction.

• Crosshatch creates diagonal brushstrokes that crisscross.

• Dark Strokes paints dark areas of your image with short, tight, dark strokes, 
and paints light areas with long, white strokes.

• Ink Outlines makes your image look like it was drawn with fine ink lines.

• Spatter gives the effect you’d get from a spatter airbrush.

• Sprayed Strokes paints your image with diagonal, sprayed strokes in its domi-
nant colors.

• Sumi-e gives the effect of drawing with a wet brush full of black ink, in a Japa-
nese-influenced style.

Distort
These filters warp your image in a variety of ways:

• Diffuse Glow makes your image look as though you’re viewing it through a soft 
diffusion filter.

• Displace lets you create a map to tell Elements how to distort your image.

• Glass makes your image look like you’re viewing it through various kinds of 
glass, depending on the settings you choose.

• Liquify (page 487).

• Ocean Ripple gives an underwater effect by adding ripples to your image.

• Pinch pulls the edges of your photo toward the center.

• Polar Coordinates lets you create what’s called a cylinder anamorphosis. With 
this kind of distortion, the image would look normal if you viewed its reflection 
it in a mirrored cylinder. It’s also good for projects like creating rainbow effects.

• Ripple creates a pattern like ripples on the surface of water. While the Ocean 
Ripple filter makes it look like you’re viewing a regular object through a distort-
ing medium like water, this filter makes the objects themselves ripple.

• Shear distorts your image along a curve.

• Spherize makes your image expand out like a balloon.

• Twirl spins your photo, rotating a selection more in the center than at the edge, 
producing a twirled pattern.



614 Photoshop Elements 10: The Missing Manual

Filter Menu

• Wave creates a rippled pattern but with more control than the Ripple filter gives 
you.

• ZigZag creates a bent, zigzagging effect that’s strongest in the center of the area 
you apply the filter to.

Noise
Use these filters to add noise (graininess) to your photos or to remove noise from 
them (unless otherwise specified, these filters are explained on page 316):

• Add Noise (page 443)

• Despeckle 

• Dust & Scratches 

• Median 

• Reduce Noise (page 442)

Pixelate
These filters break up your photo into spots or blocks of various kinds:

• Color Halftone adds the kind of dotted pattern you see in things that have been 
color-printed by a commercial press.

• Crystallize breaks your image into polygonal blocks of color.

• Facet reduces your image to blocks of solid color.

• Fragment makes your image look blurry and offset.

• Mezzotint creates an effect something like that of a mezzotint engraving.

• Mosaic breaks your image down to square blocks of color.

• Pointillize makes your photo look like it’s made of many dots of color.

Render
This is a diverse but powerful group of filters that transform your photos in many ways:

• Clouds covers your image with clouds made up of your Foreground and Back-
ground colors.

• Difference Clouds also creates clouds, but blends them in your image in Dif-
ference mode.

• Fibers creates an effect like spun and woven fibers.

• Lens Flare creates starry bright spots like you’d get from a camera lens flare.
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• Lighting Effects is a complex filter for changing the light in your photo. For an 
in-depth tutorial on how to use this filter, see this book’s Missing CD page at 
www.missingmanuals.com.

• Texture Fill lets you use a grayscale image as a texture for your photo.

Sketch
Here’s another group of artistic filters. Most of them make your image look like it 
was drawn with a pencil or graphics pen:

• Bas Relief gives your photo a slightly raised appearance, as though it’s carved 
in low relief.

• Chalk & Charcoal makes your photo look like it was sketched with a combina-
tion of chalk and charcoal.

• Charcoal gives a smudgy effect to your image, like a charcoal drawing.

• Chrome is supposed to make your image look like polished chrome, but you 
might prefer the Wow Chrome Layer styles in the Effects panel (page 458).

• Conté Crayon makes your image look like it was drawn with Conté crayons (a 
drawing medium originally made of graphite and wax, now made from chalks, 
that’s used for making bold strokes) using your Foreground and Background colors.

• Graphic Pen makes the details in your image look like they were drawn with a 
fine pen set to your Foreground color, on paper that matches your Background 
color.

• Halftone Pattern gives the dotted effect of a halftone screen, like you see in 
printed illustrations. The effect only looks like a halftone—this filter doesn’t cre-
ate a true halftone that your print shop might request.

• Note Paper makes your image look like it’s on handmade paper. Your Back-
ground color shows through in spots in dark areas.

• Photocopy makes your photo look like a Xerox copy.

• Plaster makes your image look like it was molded in wet plaster.

• Reticulation creates an effect you might get from film emulsion—dark areas 
clump and brighter areas appear more lightly grained.

• Stamp makes your image look like an impression from a rubber stamp.

• Torn Edges makes your photo look like it’s made from torn pieces of paper.

• Water Paper makes your photo look like it was painted on wet paper, so the 
colors run together.
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Stylize
These filters create special effects by displacing the pixels in your image or increas-
ing contrast:

• Diffuse makes your photo less focused by shuffling the pixels according to the 
settings you choose.

• Emboss makes objects in your image appear stamped or raised.

• Extrude gives a 3-D effect by pushing some of the pixels in your image up, 
something like toothpaste squeezed from a tube.

• Find Edges emphasizes the edges of your image against a white background.

• Glowing Edges adds a neon-like glow to the edges of objects in your photo.

• Solarize produces an effect like what you’d get by briefly exposing a photo print 
to light while you’re developing it. It combines a negative and a positive image.

• Tiles breaks up your image into individual tiles. You can choose how much to 
offset them.

• Trace Contour outlines areas where there are major transitions in brightness. 
The result is supposed to be something like a contour map.

• Wind makes your image look windblown.

Texture
These filters change the surface of your photo to look like it was made from another 
material:

• Craquelure produces a surface effect like cracked plaster.

• Grain adds different kinds of graininess to your photo.

• Mosaic Tiles is supposed to make your photo look like it’s made of tiles with 
grout between them.

• Patchwork reduces your image to squares filled with the image’s predominant colors.

• Stained Glass is supposed to make your photo look like it’s made of stained 
glass, but the effect is usually more like a mosaic.

• Texturizer makes your photo look like it’s on canvas or brick. You can also se-
lect a file to use as a texture.
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Video
These filters are for use with video images:

• De-Interlace smoothes images captured from video by removing the odd or 
even interlaced lines.

• NTSC Colors restricts your image’s colors to those suitable for displaying on a 
TV screen.

Other
This is a group of fairly technical filters:

• Custom lets you create your own filter.

• High Pass is discussed on page 265.

• Maximum replaces pixels’ brightness values with the highest and lowest values 
of surrounding pixels. It spreads out white areas and shrinks dark areas.

• Minimum does the opposite of the Maximum filter: It spreads out dark areas 
and shrinks white ones.

• Offset moves your selection by the number of pixels you specify.

Digimarc
Use this filter to check for Digimarc watermarks in photos. Digimarc is a commer-
cial system that lets subscribers enter their information in a database so that anyone 
who gets one of their photos can find out who the copyright holder is by searching 
the Digimarc database.

View Menu
This menu’s commands let you choose different ways to see your image onscreen. 
For more details on adjusting your view, see page 107.

New Window for…
This command lets you create a duplicate window for your image so you can see it 
at two different magnification levels at once. The new window goes away when you 
close your image—it doesn’t create a copy of your photo.

Zoom In
To increase the view size, you can choose this menu item, press Ctrl+=/�+=, or use 
the Zoom tool (page 111).
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Zoom Out
To reduce the view size, choose this menu item, press Ctrl+–/�-–, or use the Zoom 
tool (page 111).

Fit on Screen
Use this command or press Ctrl+0/�-0 (that’s the number zero, not the letter O) to 
make your photo as large as it can be without your having to scroll to see parts of it.

Actual Pixels
Choose this option or press Ctrl+1/�-1 to see your image in the exact size it would 
appear on the Web or in other programs that can’t adjust view size like Elements can.

Print Size
Makes Elements take its best guess as to how large your image would print at its cur-
rent resolution (page 119).

Selection
When this menu item is turned on, the outlines of your selections are visible. You 
can toggle this setting off and on here, or by pressing Ctrl+H/�-H.

Rulers
If you want to see rulers around the edges of your image window, toggle them on and off 
here, or by pressing Shift+Ctrl+R/Shift-�-R. You can adjust the unit of measurement 
in Edit➝Preferences➝Units & Rulers/Photoshop Elements➝Preferences➝Units & 
Rulers.

Grid
If you want to see a measurement and alignment grid on your photos, use this setting 
or press Ctrl+’/�+’ (the apostrophe key) to toggle it on and off. You can adjust the 
grid’s size in Edit➝Preferences➝Grid/Photoshop Elements➝Preferences➝Grid.

Guides
Guides (page 96) help you align objects in your files. If your image has guides in it, 
toggle their visibility off and on here, or press Ctrl+;/�+; (the semicolon key).
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Notes
If you receive an image created in Photoshop that includes notes, choose this menu 
item to see them. (You can’t create notes in Elements.)

Snap to
If you want to control Elements’ autogrid (a hidden system that determines how pre-
cisely you can place things when you move them in your images), use these commands.

• Guides. When you’re working with a file that includes guidelines, this setting is 
where you toggle on and off whether objects you add will snap to those guide-
lines.

• Grid. When this setting is turned on, Elements automatically jumps to the near-
est gridline. If the way your tools and selections keep jumping away from you is 
annoying, then turn off the grid here; then everything stays exactly where you 
place it. (You have to make the grid visible—by going to View➝Grid—before 
you can change its settings.)

Lock Guides
If you’ve created guides (page 96) in your image and you don’t want them to move, 
use this menu item or press Alt+Ctrl+;/Option-�-; (the semicolon key) to fix them 
in place.

Clear Guides
If you have guides (page 96) in your image and you want to get rid of them, choose 
this menu item.

New Guide
To create a nonprinting guideline (page 96) in your image so that you can easily align 
objects, select this menu item.

Window Menu
This menu controls which panels and bins you see, and lets you adjust how your im-
age tabs or windows display. Windows that are currently visible have a checkmark 
next to their names.
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Images
Use these commands to control how Elements displays your images (your choices 
are explained in detail on page 109):

• Tile. Your images appear edge to edge so that all the windows or tabs are equally 
visible.

• Cascade. This is the view you see when you start Elements for the first time. 
Your image windows appear in overlapping stacks. (You can’t choose this menu 
item when using tabs.)

• Float in Window. Choose this command to make the active image tab 
into a floating window. (You first have to turn on floating windows in 
Edit➝Preferences➝General/Photoshop Elements➝Preferences➝General.)

• Float All in Windows. If you’ve turned on floating windows, choose this and all 
your image tabs turn into windows.

• Consolidate All to Tabs. If you have floating windows and you want to go back 
to tabbed view, select this item.

• New Window. This is the same as the View menu’s “New Window for…” com-
mand (page 110). It opens a separate view of your image, not a duplicate file.

• Minimize (Mac only). If you have tabs, choosing this item or pressing �-M 
sends the entire Elements window to the Dock. If you have floating windows, 
it minimizes only the image window.

• Bring All to Front (Mac only). Choose this command to bring all your open 
Elements images front and center.

• Match Zoom. Choose Match Zoom to get the same magnification level in all 
open windows as in the active image window.

• Match Location. When you have only part of a photo visible in a window, 
choose this command to make all open windows display the same part of their 
images, like the upper-left corner, for example.

Tools
Select this menu item to hides or shows the Tools panel (page 31).

Adjustments
This option shows and hides the Adjustments panel (page 218).

Color Swatches
Select this item to show or hide the Color Swatches panel (page 259).
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Content
The Content panel holds frames, backgrounds, graphics, shapes, themes, and text 
effects to use in projects. It’s always visible in Create mode, but if you want to see it 
in Edit mode as well, select this item. See page 522 for more about using this panel.

Effects
This menu item shows and hides the Effects panel, from which you apply filters, 
photo effects, and Layer styles. See page 436.

Favorites
You can put your favorite items from the Content and Effects panels into the Favor-
ites panel for easier access (page 524). Like the Content panel, the Favorites panel is 
always visible in Create mode, but you can use this menu item to make it visible in 
Full Edit or to hide it again once it’s visible.

Histogram
Select this item to show or hide the Histogram in its own panel (page 245).

Info
Select this option to bring up a panel with information about your photos, like their 
file sizes and color values.

Layers
Show or hide the Layers panel by choosing this item. See page 188.

Navigator
Turn the Navigator (page 114) off and on here. The Navigator lets you adjust which 
portion of a large image is visible onscreen and adjust the zoom level.

Undo History
This item setting makes the Undo History panel visible or hides it. This panel shows 
a record of all the changes to your image up to the number of states you set in Edit➝
Preferences➝Performance➝History States/Photoshop Elements➝Preferences➝Pe
rformance➝History States. Page 37 has more about this panel.
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Application Frame (Mac only)
When this is turned on, Elements appears as a solid, resizable window. Turn it off 
and you lose the solid desktop background and the rest of the Elements interface 
clings around the edges of your screen, the way it did in Elements 6. When Applica-
tion Frame is turned on, the Application bar (explained next) is grayed out, because 
it’s always on when the Application Frame is on.

Application Bar (Mac only)
This is the top bar of the Elements window, the one that shows the Elements logo 
(the dark blue square with lighter blue squares on it); the shortcut buttons for New 
File, Bridge, Save, and Help; the Arrange Menu (page 109); and the buttons for Reset 
Panels, Undo, and Redo. If you want, you can hide it by turning it off here, but only 
if you first turn off the Application Frame, described above.

Panel Bin
This setting minimizes (hides) and maximizes (reopens) the Panel bin (page 26). 
You can also just click the edge of the bin to hide or expand it.

Reset Panels
Use this command to return all your panels to their original locations.

Welcome
Choose this menu item to see the Welcome screen that appears in Windows when 
Elements starts up.

Project Bin
This setting shows and hides the Project bin (page 29).

Image Windows/Tabs
At the bottom of the Window menu, you see a list of all the files you have open in 
Elements. Choose one to bring it to the front as the active window or tab.
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Help Menu
The menu is where you find the Elements’ Help files, and information about the program.

Search Box (Mac only)
You can type a term into this box to search the program’s menus, not the Elements 
Help Files. 

Photoshop Elements Help
When you select this menu item or press F1/�-?, Adobe Community Help launches 
to show you Adobe’s Help files. (This is online content, but you view it in a special 
window, not in a web browser.)

Getting Started
This menu item takes you to a section of Adobe’s website that includes video tutori-
als to help newbies.

Key Concepts
Elements’ Help files include a glossary of digital-imaging terms. If you’re wondering 
what a particular term means, choose this menu item and it’ll take you to the online 
glossary so you can look it up.

Support
Select this option to go to Adobe’s online Support area and knowledgebase.

Video Tutorials
Choose this menu item to go to the video tutorials section of Adobe’s support site, 
where you can watch videos on how to perform popular Elements tasks.

Forum
This takes you to Adobe’s online support forum for Photoshop Elements.

About Photoshop Elements (Windows only)
Choose this item to see a scrolling window with info about the version of Elements 
you’ve got. You’ll also see a very long list of patents and credits—a testament to the 
complexity of Elements’ engineering. (On a Mac, you’ll find this and the next two 
items in this list in the Photoshop Elements menu instead.)
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About Plug-In (Windows only)
Select this option for a long pop-out menu displaying all the plug-ins in your copy 
of Elements. Choose a plug-in from the list to see its version number and date in-
formation.

Patent and Legal Notices (Windows only)
This menu item displays a long list of the various patents for Elements, as well as 
trademark info for some of the components used in the program.

System Info
Choose this item to see a window with information about Elements and your op-
erating system. If you can’t remember which Windows service pack you have, for 
instance, then you can find out here. 

Product Registration
If you’re not in the U.S. and you didn’t register Elements with Adobe the first time 
you used the program, you can choose this menu item to bring up the registration 
window again. In the U.S., it brings up the same screen you saw when you installed 
Elements (on a Mac) or launched it for the first time (Windows), the one where you 
can enter or create an Adobe ID (page 22). 

Deactivate
Elements uses activation, a process that limits the number of computers on which 
you can install your copy of Elements (you’re allowed to install it on two hard drives). 
If you need to uninstall Elements so you can move it to a new computer, be sure to 
use this command to deactivate it on the old computer first.

Updates
This is where you check for updates to Elements components. 

Elements Inspiration Browser
The Inspiration Browser (page 35) links you to a number of video and PDF tutorials. 
You can launch it from here.
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Adobe Product Improvement Program
Adobe would like to keep tabs on what you do in Elements to help them understand 
what features and improvements to include in future versions of Elements. If you 
participate in the Product Improvement Program, your computer sends information 
to Adobe about what you do in Elements. Whether you think this is a swell idea or 
a creepy invasion of privacy, choose this menu item to sign up or tell Adobe “No, 
thanks.” If you’re not sure whether you’re in the program, you can see your current 
status at the top of the window that appears when you select this menu item.

Arrange Menu
The exact location of this menu varies. In Windows on a large screen, it appears to 
the right of the Help Menu. On a Mac or if you’ve made the main Elements win-
dow smaller than full-screen in Windows, it appears in another row above the main 
menus, as do the rest of the menus listed here. (Macs also have three shortcut but-
tons to the left of the Arrange menu. From left to right they’re for making a new file, 
saving files, and calling up the Help files.

This menu (whose icon is a gray square divided up into smaller squares and rect-
angles) lets you organize your image windows and tabs to suit your workflow. The 
top part of the menu consists of thumbnails for the different ways you can tile your 
image views. Clicking a thumbnail puts you in a tabbed, tiled view, even if you began 
with floating windows. Just click the thumbnail that shows the layout you want. The 
large, single rectangle at the menu’s upper left returns you to the basic tab view of 
one visible image tab with the others tucked away behind it.

Tip: To tile floating windows, go to Window➝Images➝Tile.

The bottom part of the menu rounds up several useful view commands also found 
in other menus:

• New Window. This is the same as the View menu’s “New Window for…” com-
mand; it opens a separate view of your image, not a duplicate file.

• Actual Pixels. Choose this option or press Ctrl+1/�-1 to see your image the ex-
act size it would appear on the Web or in other programs that can’t adjust view 
size as Elements can.

• Fit On Screen. Use this command or press Ctrl+0/�-0 (that’s a zero, not the let-
ter O) to make your photo as large as it can be without you having to scroll to 
see parts of it.

• Match Zoom. Choose this item to make the magnification level of all open 
windows match the active image window.
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• Match Location. When you have only part of a photo visible in a window, 
choose this item to make all your open windows display the same part of their 
images, like the upper-left corner, for example.

• Match Zoom and Location. This combines the two preceding commands.

Welcome Button
When you’re signed on to your Photoshop.com account (page 21), you’ll see text 
that says “Welcome, <your name>”. Click it to go directly to your Photoshop.com 
account online. If you’re not signed on, you see “Sign In” instead.

Create New Adobe ID
If you don’t have an Adobe ID (which you need to use Photoshop.com), click this 
button to create one. You can also do this from any place in Elements that takes you 
to Photoshop.com).

Reset Panels
With Elements’ customizable interface, it’s easy to lose track of things. Click this but-
ton to put everything back where it was the first time you started Elements.

Undo
Click this button or press Ctrl+Z/�-Z to undo your last action.

Redo
Click here or press Ctrl+Y/�-Y to redo your last action.

Organizer
Click here to go to the Organizer.

Welcome Screen
Click this button (which looks like a little house) when you want to see the Welcome 
screen (page 16) that appears when you launch Elements.


